USER GUIDE

Provider Assessment: Home and Community Based Settings (HCBS) Check List

Overview:

The Home and Community Based Settings Check List is an assessment to ensure that individuals receiving services and

supports through the HCBS programs have full access to the benefits of community living and are able to receive services
in the most integrated setting.

Providers will have access to only create the HCBS Check List Assessments screen. Only access to the particular provider’s
own listing will be granted.

Upon completing the assessment, the Provider cannot edit the assessment. The Regional Office role may edit the assessment
by making a copy of the provider’s completed assessment.

The assessment is accessible by providers along with the regional and central office staff.

How to use the HCBS Check List Assessment screen:

On the My ADIDIS page, click on the Providers chapter.

About

Py s

Change Role
| MR Provider V|
File - Print
| My ADIDIS | Fenem
[Clients | [Tasks |
Quick Search El Notes El My Claims
4 Complete Bulk Void and Replace
[l alert Motes Batch Claim Entry
[1} Unread Alert Notes Single Claim Entry
| Provider Name V‘ = My Management
Advanced Search Panding Investigation Assessment Quaus
Print Queue
| Clients |
o Click on Providers chapter.
Claims
| Reports |
| Sign Out |
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Next the “Providers” screen is displayed. Only the information for your particular provider will appear.

About

Providers

Change Role

|MR Provider V|

Last Updated by at
8/29/2014 12:16:04 PH

‘ My ADIDIS | Fie - print

Edit -
Quick Search

| ] Active Available
| Provider Name V| Provider Number | | Capacity Availability
Provider Name
Advanced Search
providers | Enrollment | Waorkers | Services | Provider Level Budgets | Provider ID Numbers | Categaries
‘ Clients | Assessment | Credentials | Experience
‘ | Basic Information
: Provider Name I
\ Claims | I Funded By
I
Reports |
P Short Name (DBA) Medicaid Approved
‘ Sign Out | Cantar Numbar | Provider Type
Medicaid Number Exclude from Dropdown
EIN/SSN I Certification Unit
IRSStatus Contracts Management
Active Comment
‘fear Incorporated
Contact Information
Cantact Name I
I County
I
Street N oo I
Strest 2 Extension
City Fax I
State Email
Zip Code Website
Region
Correspondence Address
Correspondence Street Correspondence State
Correspondence Street 2 Correspandence Zip Code
Correspondence City
Mailing Address
Parent Company I
I Mailing Strest 2
]
Attach Parent Company ; )
Adkdress Mailing City
Mailing Address Same as ;
Contact Addrece Mailing State/Province
Mailing Name |

Select the Assessment tab. The “Add Assessment” option appears at the top in the Menu Bar. Select “Add Assessment.”

About "
Select the Assessment tab. "Add Assessment” will
. === = Assessment
Change Role 5 appear at the top in the Menu Bar.
| MR Provider ] ]
Last Updated by | at
8/29/2014 12:16:04 PM
| My ADIDIS | Fie-hdd - Print
View Inguiries
Quick Search
l:l Provider ID | Active Available
- Provider Number - Capacity Availability
Providers v
Provider Name I
‘ Provider Name ~ ]
Advanced Searc Providers fEnrollment Workers Services Provider Level Budgets Provider ID Mumbers Categories
Assessment Credentials Experience
| Clients

Filter

|
| | Assessment WV
[ claims | Search || Reset
|

| Reports

| Sign Out |
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The Assessment screen displays the File Menu in two areas. The File Menu in the upper left corner of the screen offers
the same menu options that are shown in the menu below it.

File

Assessment

9/10/2014 11:02 AM

File - Spell Check - Save Assessment - Save and Close Assessment - - Print - Close Assessment

F —
Please Select Type:| v =% The File Menu lists the following options:
Sese Eee e Spell Check
Provider Assessment Save Assessment
Review * Worker * e [[clear oot Save and Close assessment
Review Date * status - Print
Fund Code * Approved By [ Close Assessment
Approved By | Expiration Date —
Expiration Date
I —
All fields with the * are required fields where data must be entered.
File
. All fields with the * are required fields
where data must be entered. Assessment

9/10/2014 11:02 AM

File - Spell Check - Save Assessment - Save and Close Assessqes® . Frint - Close Aszessment

Please Select Type: | / hd

Provider V

Review * Worker * e [ cear o

Review Date * o/10/2014 | F Status *

Fund Code * Approved By e

Approved By

Expiration Date

|
|

Expiration Date
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The drop down menu lists several Assessments. Click on the dropdown ﬂ to display the list then select the HCBS
CheckL ist Assessment.

From the drop down menu, select HCBS CheckList .

Assessment

9/10/2014 11:34 AM

Sile - Spell Check - Save Assessment - Save and Close Assessment - - Print - Close Assessmghi

!

Approved By Expiration Date

Expiration Date

Please Select Type: | v

Provider Assessment

Review * Worker * [——— [uxe] Cear | Detaits
Review Date * 9/10/2014  [E Status *

Fund Code * Approved By Datails
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Below is the screen shot for the “HCBS CheckList.” This assessment screen contains the “Provider Assessment” which is
the provider’s identifying information and three sections with the assessment questions. The questions’ sections are Section

| - HCBS CRITERIA, Section Il - RESIDENTIAL SETTING SPECIFIC and Section 11l - SETTINGS THAT ARE NOT
HOME AND COMMUNITY BASED.

Complete each field below. All fields with the asterisk * are required fields where data must be entered.

File

[

All fields with the * are required fields
where data must be entered. Assessment

9/10/2014 12:38 PM
File - Spell Check - Save Assessment - Save and Close Assgae#ent - - Print - Close Assessme

Please Select Type: | HCBS CheckLispr™ ~

M
Review * _ [—— [eee] clear | petai=

Review Date * 9/10/2014 Status *
Fund Code * [ v Approved By [ e
Approved By Expiration Date

s
g
]

Expiration Date

Region®*

’I l

Provider Type*

() subContractor

Provider/Certified [ I—|
SubContractor® e

Service Type* |

v

Section I: HCBS CRITERIA

1. The setting is integrated in and supports full access to the community (work, live, recreate, and other services). There are opportunities to seek employment and
work in integrated settings, engage in community life, and control personal resources.

- Are transportation and other supports providad so that people can regularly access services similar to those used by the community at large?

- Can people regularly interact directly with other members of the community who are not paid to do so?

Response # I-1: If YES, CHECK BOX and List Evidence to Support in the Comments Area / If NO, DO NOT Check Box and Explain Why in Comments Area Below.

|

Comments# I-1:%

2. The setting is selected from an array of options that are non-disability specific (includes private room in home)
- The setting is selected by people from among residential and day options that include generic settings.
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The “Review” drop down menu lists several options. Click on the dropdown ﬂ to display the list then select
Assessment.

From the "Review" dropdown, A t
select Assessment . ssessmen
0f10/2014 12:28 PM

Print - Close Assessment

Please Select Types | HCBS CheckList 7 %
Provider Assessment /

—— worker * [— | [ciear] e
Review Date * 9/10/2014 [T Status = [prait V]

Fund Code *

Approved By I o

Expiration Date

Approved By

|

Expiration Date

Region*

Provider Type*

() subContractor
Provider/Certified ‘ |—|
SubContractor*
Service Typa® | vl

Section I: HCBS CRITERIA

1. The setting is integrated in and supports full access to the community (work, live, recreate, and other services). There are opportunities to seek employment and
work in integrated settings, engage in community life, and control personal resources.

- Are transportation and other supports provided so that people can regularly access services similar to those used by the community at large?
- Can people regularly interact directly with other members of the community who are not paid to do so?

Response # I-1: If YES, CHECK BOX and List Evidence to Support in the Comments Area / If NO, DO NOT Check Box and Explain Why in Comments Area Below.

O

Comments# I-1:%

2. The setting is selected from an array of options that are non-disability specific (includes private room in home)

- The setting is selected by people from among residential and day options that include generic settings.
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In the Provider Assessment area, several fields will automatically populate. To edit the “Review Date”, type the new date
using MM/DD/YYYY or dates may be selected from the calendar icon. The “Worker” is automatically populated with the

worker’s name. In the “Status” field, the dropdown offers several choices. Select the appropriate item. The “Fund Code”
is always MR.

The fields such as “Approved By”, “Approved Date”, and “Expiration Date” are grayed out and access is not granted in
the Provider’s role.

’ Several fields are automatically populated.
Assessment

0/10/2014 12:38 PM

File - Spell Check - Save Assessment - Save and Close Assessment Print - Close Assessmel

Please Select Type: | HCBS CheckList yd ¥
Provider Assessment
Review Worker * [N | [ciear| oot
Review Date * 9/10/2014 [ Status *
Fund Code * Approved By I -
Approved By [ Expiration Date | Grayed
Expiration Date — out fields.

ceyen

Provider Type*

®) Contractor

() subContractor
Provider/Certified | |—|
SubContractor®
s L]
Service Type* | v|

Section I: HCBS CRITERIA

1. The setting is integrated in and supports full access to the community (work, live, recreate, and other services). There are opportunities to seek employment and
work in integrated settings, engage in community life, and control personal resources.

- Are transportation and other supports provided so that people can regularly access services similar to those used by the community at large?
- Can people regularly interact directly with other members of the community who are not paid to do so?

Response # I-1: If YES, CHECK BOX and List Evidence to Support in the Comments Area / If NO, DO NOT Check Box and Explain Why in Comments Area Below.

O

Comments# I-1:%

2. The setting is selected from an array of options that are non-disability specific (includes private room in home)

- The setting is selected by people from among residential and day options that include generic settings.
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Set the Fund Code to “MR” and change Status to “Complete.”

Select "MR" for the Fund Code. Assessment

9/12/2014 10:20 AM

File - Spell Check - Save Assessment - Save and Close Agffessment - - Print - Close Assessment

/

Please Select Type: | HCBS CheckList v

Provider Assessment

Review *

Worker * [ —— [ece] Elear | petsits

Status *
roprovedsy [ o
Details Expiration Date r—

Review Date *

Fund Code *

Approved By

Expiration Date

Region™

Provider Type*

Provider Certified | |—|
SubContractor*

Service Type® | v|

s/ opmct —

BS CRITERIA

1. The setting is integrated in and supports full access to the community (work, live, recreate, and other services). There are opportunities to seek employment and
work in integrated settings, engage in community life, and control personal resources.

- Are transportation and other supports provided so that people can regularly access services similar to those used by the community at large?

- Can people regularly interact directly with other members of the community who are not paid to do so?

Response # I-1: If YES, CHECK BOX and List Evidence to Support in the Comments Area / If NO, DO NOT Check Box and Explain Why in Comments Area Below.

|

Comments# I-1:*

2. The setting is selected from an array of options that are non-disability specific (includes private room in home)

- Tha cattinn ic calartad hu nannla fram amane racidantial and dow anlinne that inclada canaric catfinaes

Page 8 of 31



As a reminder, all fields with the asterisk * are required fields where data must be entered. Complete each field.

Select the appropriate “Region” by clicking on the dropdown ﬂ and choosing from the dropdown.

Select the radio button that defines the “Provider Type.”

Assessment

Di 9/10/2014 1:57 PM

File - Spell Check - Save Assessment - Save and Close Assessment - - Print - Close Assessment

Please Select Type: | HCBS CheckList V]

Provider Assessment

Review * Worker * [ [l o
.

Review Date * 9/10/2014 [ Status *
Fund Code * Approved By _> Details
Approved By Expiration Date

1

Expiration Date

Region* <r Choose Region from dropdown.

Provider Type® ® Contractor & Select Provider Type by clicking on radio button.
O subCantractor Only one button may be selected.

Provider Certified | |—|

SubContractor*

Section I: HCBS CRITERIA

1. The setting is integrated in and supports full access to the community (work, live, recreate, and other services). There are opportunities to seek employment and
work in integrated settings, engage in community life, and control personal resources.

- Are transportation and other supports provided so that people can regularly access services similar to those used by the community at large?
- Can people regularly interact directly with other members of the community who are not paid to do so?

Response # I-1: If YES, CHECK BOX and List Evidence to Support in the Comments Area / If NO, DO NOT Check Box and Explain Why in Comments Area Below.

O

Comments# I-1:*

2. The setting is selected from an array of options that are non-disability specific (includes private room in home)

- The setting is selected by people from among residential and day options that include generic settings.
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By clicking on the ellipse E button, a list of Provider and Certified SubContractor names will appear.

The “Provider and Certified SubContractor” dropdown will only show the workers’ providers.

Assessment

9/10/2014 1:57 PM

File - Spell Check - Save Assessment - Save and Close Assessment - - Print - Close Assessment

Please Select Type: | HCBS CheckList V|

Provider Assessment

Raviaw * Workar * — Lo lme ] et
- dB I -
Review Date * 9/10/2014 a Approved By Details
Expirati Dat
Fund Code = spiration Date

Approved By [

Expiration Date Expired

wegon

Provider Type* ontractor By clicking on the ellipse, the names of the Providers
O subContractor / and Certified SubContractors will display.

Provider/ Certified

SubComtiacter [C——

Site#* l:lsne: is a Required Field.
Section I: HCBS CRITERIA

1. The setting is integrated in and supports full access to the community (work, live, recreate, and other services). There are opportunities to seek employment and
work in integrated settings, engage in community life, and control personal resources.

- Are transportation and other supports provided so that people can regularly access services similar to those used by the community at large?
- Can people regularly interact directly with other members of the community who are not paid to do so?

Response # I-1: If YES, CHECK BOX and List Evidence to Support in the Comments Area / If NO, DO NOT Check Box and Explain Why in Comments Area Below.

O

Comments# I-1:%

2. The setting is selected from an array of options that are non-disability specific (includes private room in home)

- The setting is selected by people from among residential and day options that include generic settings.
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A dialog box will appear. Type in the provider’s full or partial name then click the Search button.

Assessment

9/12/2014 10:39 AM
File - Spell Check - Save Assessment - Save and Close Assessment - - Print - Close Assessment

Please Select Type: | HCBS CheckList v]

Provider Assessment

— Werker *
Review Date + Status *

Fund Code * Approved By
Approved Date IWT Expiration Da
Expired Provider SearchKeys| | [] Get All Provider Records

Region*

Provider Type*

SubContractert | [-]

s —

Service Type* ‘

s oy ]

Enter provider's name (full or partial) then click on Search.

1. The setting is integrated in and supports full access to the com
work in integrated settings, engage in community life, and control

ment and

- Are portation and other supports provided so that paople can regularly access

- Can people regularly interact directly with othar bers of the ity who

Response # I-1: If YES, CHECK BOX and List Evidence to Support in the Comments Area / If NO, DO NOT Check Box and Explain Why in Comments Area Below.

O

Comments# I-1:%

2. The setting is selected from an array of options that are non-disability specific (includes private room in home)
- The setting is selected by people from among residential and day options that include generic settings.
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A list of vendors’ names will appear. Select from the list by clicking on the vendor’s name.

File

Assessment
3 9/12/72014 10:39 AM
File - Spell Check - Save Assessment - Save and Close Assessment - - Print - Close Assessment
Please Select Type: | HCBS CheckList v| A list of vendors' names will appear. Select

a vendor.
Provider Assessment

Review * Worker ¢ S =P R
Review Date *

Fund Code * [vr V] Approved By
Approved Date I‘JI].Z[T Expiration Dak

Expired

Status *

Region™

Provider Type*

() subContractor

Provider/Certified
SubContractor* | |—|

Service Type® |

Size/Capacity™*

1. The setting is integrated in and supports full access to the com
work in integrated settings, engage in community life, and control

ment and

- Are transportation and other supports provided so that people can regularly access

- Can people regularly interact directly with other bers of the ity who ar

Response # I-1: If YES, CHECK BOX and List Evidence to Support in the Comments Area / If NO, DO NOT Check Box and Explain Why in Comments Area Below.

O

Comments# I-1:*

2. The setting is selected from an array of options that are non-disability specific (includes private room in home)

- The setting is selected by people from among residential and day options that include generic settings.
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After selecting the provider’s name, the name of the provider will appear in the field.

Assessment

9/12/2014 10:39 AM
File - Spell Check - Save Assessment - Save and Close Assessment - - Print - Close Assessment

Please Select Type: | HCBS CheckList V]

Provider Assessment

Review = Worker * M [ clear|oetis
Review Date * 9/12/2014 | = Status *

Fund Coda * R v roprovedey N oo
Approved Date 9/12/2014 Expiration Date

Expired

Region*

[Region1 K

Provider Type*
(O subCentractor

v 4= After clicking on the The Provider/Ceriified
SubContractor's name, it will appear in the field.

Service Type* ‘ v|

s o ]
Section I: HCBS CRITERIA

1. The setting is integrated in and supports full access to the community (work, live, recreate, and other services). There are opportunities to seek employment and
work in integrated settings, engage in community life, and control personal resources.

- Are transportation and other supports provided so that people can regularly access services similar to those usad by the community at large?

- Can people regularly interact directly with other members of the community who are not paid to do so?

Response # I-1: If YES, CHECK BOX and List Evidence to Support in the Comments Area / If NO, DO NOT Check Box and Explain Why in Comments Area Below.

O

Comments# I-1:%

2. The setting is selected from an array of options that are non-disability specific (includes private room in home)

- The setting is selected by people from among residential and day options that include generic settings.
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The Site # field is a required field. Type the Site # information in the available area.

Assessment

Di . 9/10/2014 1:57 PM

File - Spell Check - Save Assessment - Save and Close Assessment - - Print - Close Assessment

\pproved By I -
[y e —— Expiration Data —

—

Review Date * Status * Pending A

Approved By [ Approved Date —

Expiration Date —— Expired

Region* Regionl W

Provider Type*

Please Select Type: | HCBS CheckList

Fund Code *

ontractor

ubContractor

provtder/Cartified 1 ; ;
SubContractor™ D s Typeinthe Site#.
e 999999 X Site‘-v is a Required Field.

Service Type™® |

VlServi:e Type is a Required Field.

Sec BS CRITERIA

1. The setting is integrated in and supports full access to the community (work, live, recreate, and other services). There are opportunities to seek employment and
work in integrated settings, engage in community life, and control personal resources.

- Are transportation and other supports provided so that people can regularly access services similar to those used by the community at large?

- Can people regularly interact directly with other members of the community who are not paid to do so?

Response # I-1: If YES, CHECK BOX and List Evidence to Support in the Comments Area / If NO, DO NOT Check Box and Explain Why in Comments Area Below.

O

Comments# I-1:*

2. The setting is selected from an array of options that are non-disability specific (includes private room in home)

- The setting is selected by people from among residential and day optiens that include generic settings.

Page 14 of 31



The Service Type field is also a required field. Select the appropriate “Service Type” by clicking on the dropdown ﬂ
and choosing from the dropdown.

The dropdown options are:

e Residential < 6 pp,

e Residential HUD Homes,

o Residential > 6 pp Not Health/Behavioral Homes
o Day Hab

e Pre Vocation (Workshop)

o Employment (Workcrew)

File

Assessment

9/12/2014 10:39 AM

File - Spell Check - Save Assessment - Save and Close Assessment - - Print - Close Assassment

Please Select Type: | HCBS CheckList V]

Provider Assessment

Review * Worker * (N [_loealoei
Review Date * Status *

Fund Code * Approved By T
Approved Date W Expiration Date

Expired

|

Region™ Regionl W

i *
Provider Type ®) Contractor

SubContractor

Select a Service Type from the dropdown options.

ﬂ'

Provider/ Certified

SubContractor®
Site#™ 9995999
Service Type™ Employment {Work Crew} L

Size/Capacity*

|

Section I: HCBS CRITERIA

1. The setting is integrated in and supports full access to the community (work, live, recreate, and other services). There are opportunities to seek employment and
work in integrated settings, engage in community life, and control personal resources.

- Are transportation and other supports provided so that people can regularly access services similar to those used by the community at large?
- Can people regularly interact directly with other members of the community who are not paid to do so?

Response # I-1: If YES, CHECK BOX and List Evidence to Support in the Comments Area / If NO, DO NOT Check Box and Explain Why in Comments Area Below.

O

Comments# I-1:*

2. The setting is selected from an array of options that are non-disability specific (includes private room in home)

- The setting is selected by peonle from amena residential and dav ootions that include aeneric settinas.
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The Size/Capacity field is required.

Assessment

9/12/2014 10:39 AM
File - Spell Check - Save Assessment - Save and Close Assessment - - Print - Close Assessment

Please Select Type: | HCBS CheckList v|

Provider Assessment

Reviw - Worker
Review Date * 9/1z/2014 | ¢ Status *

Fund Code * Approved By N -
Approved Date 9/12/2014 Expiration Date

Expired

Region™ Regionl W

" +
Provider Type’ Contractor

SubContractor
e Enter the Size/Capacity.
SubContractor®

Size/Capacity*
Section I: HCBS CRITERIA

1. The setting is integrated in and supports full access to the community (work, live, recreate, and other services). There are opportu
work in integrated settings, engage in community life, and control personal resources.

- Are transportation and other supports provided so that people can regularly access services similar to those used by the community at large?

5 to seek employment and

- Can people regularly interact directly with othar members of the community who are not paid to do so?

Response # I-1: If YES, CHECK BOX and List Evidence to Support in the Comments Area / If NO, DO NOT Check Box and Explain Why in Comments Area Below.

O

Comments# I-1:%

2. The setting is selected from an array of options that are non-disability specific (includes private room in home)

- The settina is selected bv peonle from amona residential and dav ootions that include aeneric settinas.
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Below the Provider Assessment information is the beginning of the assessment questions. There are four sections with the
assessment questions.

The questions’ sections are

e Section | - HCBS CRITERIA,
e Section Il - RESIDENTIAL SETTING SPECIFIC

e Section Il - SETTINGS THAT ARE NOT HOME AND COMMUNITY BASED
e Remediation Plan

Section I and Section II’s questions are formatted the same with a checkbox to indicate the answer to the question and a
comment field that is required.

If the response is YES, the box is checked. If the response is NO, the box is not checked. See examples below.

Section I: HCBS CRITERIA

1. The setting is integrated in and supports full access to the community (work, live, recreate, and other services). There are opportunities to seek employment and
work in integrated settings, engage in community life, and control personal resources.

- Are transportation and other supports provided so that people can regularly access services similar to those used by the community at large?

- Can people regularly interact directly with other members of the community who are not paid to do so?

Response # I-1: If YES, CHECK BOX and List Evidence to Support in the Comments Area / If NO, DO NOT Check Box and Explain Why in Comments Area Below.

A

|
*** IMPORTANT ***

If the response to the question is YES then the box must be checked.
If the answer is NO, the box is |left unchecked.

In Section | and Section I, the Comments field is a required field. There is an asterisk * displayed next to the field’s
name.

If the response is YES, the box is checked and evidence to support the response is required in the comments area.

If the response is NO, the box is left unchecked and an explanation of why is required in the comments area.

Section I: HCBS CRITERIA

1. The setting is integrated in and supports full access to the community (work, live, recreate, and other services). There are opportunities to seek employment and
work in integrated settings, engage in community life, and control personal resources.

- Are transportation and other supports provided so that people can regularly access services similar to those used by the community at large?

- Can people regularly interact directly with other members of the community who are not paid to do s0?

Response # I-1: If YES, CHECK BOX and List Evidence to Support in the Commants Area / If NO, DO NOT Check Box and Explain Why in Comments Area Below.

Comments# I-1:%

Testing Comment I-1|

“** SPECIAL NOTE ***

The Comments field is a required field.
An explanation is requested if the answer is YES or NO.
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Section 111 is formatted using radio buttons to acquire the answer to the questions.
As a reminder, all fields with the asterisk * are required fields where data must be entered.

In this case, a radio button for the answers of YES or NO must be selected.

Section ITI: SETTINGS THAT ARE NOT HOME AND COMMUNITY BASED

1. Is the satting a skilled nursing setting?* i
_ Select the Yes or No Radio button.
® =3 ! :
R The answer is required.
L) No /

Comments# III-1% /

2. Is the setting

institution or ICF/IDD?*

O es

(O

Comments# I[II-2%

In Section I11, the Question and Comments fields are required fields. There is an asterisk * displayed next to the field’s
name.

If the response is YES, meaning the site automatically does not meet the HCBS requirements, an explanation of why
waiver funding is being used to support the site is required. If the response is NO, then briefly explain evidence.

Section III: SETTINGS THAT ARE NOT HOME AND COMMUNITY BASED
1, 1s the setting a skilled nursing setting?*

@ ves

(I Na

Comments# ITI-1*

“** SPECIAL NOTE ***

The Comments field is a required field.
An explanation is requested if the answer is YES or NO.

2. Is the setting an institution or ICF/IDD?*

O Yes

®no

Comments# ITI-2%

“** SPECIAL NOTE ***

The Comments field is a required field.
An explanation is requested if the answer is YES or NO.
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The last section, Remediation Plan, is also a required field. A Remediation Plan must be entered for any item that is not
met in the entire assessment. If ALL requirements are met enter “N/A” in this area.

Setting Not Meeting the Criteria Above

Remediation Plan*

Required completion.

If ALL requirements are met enter "N/A" in this area

After all required fields are completed, go to top of screen. Under the Provider Assessment information, change the
Status to “Complete.”

File

Assessment

9/12/2014 10:39 AM

File - Spell Check - Save Assessment - Save and Close Assessment - - Print - Close Assassment

Please Select Type: | HCBS CheckList V]

Provider Assessment ***IMPORTANT ***
- woser [N o] e o
:

Review Date * Status * % ¢ Change Status to "Complete."

Fund Code * Appraved By I o
Approved Date 9/12/2014 Expiration Date

Expired

Region™ Regionl W

Provider Type* 35

ontractor

(_] subContractor
SubContractor®
Site#* 9999559
Service Type* Employment (Work Crew}) hd
Size/Capacity* 25

Section I: HCBS CRITERIA

1. The setting is integrated in and supports full access to the community (work, live, recreate, and other services). There are opportunities to seek employment and
work in integrated settings, engage in community life, and control personal resources.

- Are transportation and other supports provided so that people can regularly access services similar to those used by the community at large?
- Can people regularly interact directly with other members of the community who are not paid to do so?

Response # I-1: If YES, CHECK BOX and List Evidence to Support in the Comments Area / If NO, DO NOT Check Box and Explain Why in Comments Area Below.

O

Comments# I-1:*

2. The setting is selected from an array of options that are non-disability specific (includes private room in home)

- The setting is selected by peonle from amena residential and dav ootions that include aeneric settinas.
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*xx IMPORTANT ***

After the Status is change to “Complete”, select the Save Assessment or Save and Close Assessment.

Note: All required fields must be completed before ADIDIS will allow the assessment to be saved in the system.

After all required fields are completed, select

Save A ment or Save and Close A ment. Assessment

D . 9/10/2014 1:57 PM

File - Spall Check - Save Assessment - Save and Close Assessment - - Print - Close Assessment

Please Select Type: | HCBS CheckList v|

Provider Assessment

Review * Worker * — o] Clear | Details
Review Date * 9/10/2014 q| Status ¥ Pending v
Fund Code * (1= ] site

Approved By | Approved Date
Expiration Date Expired
Region™ Regionl W
Provider Type* ontractor

) SubContractor
Provider/Certified .
SubContractor® |D m

Site#* 999399

Service Type*

1. The setting is integrated in and supports full access to the community (work, live, recreate, and other services). There are opportunities to seek employment and
work in integrated settings, engage in community life, and control personal resources.

- Are transportation and other supports provided so that people can regularly access services similar to those used by the community at large?

- Can people regularly interact directly with other members of the community who are not paid to do so?

Response # I-1: If YES, CHECK BOX and List Evidence to Support in the Comments Area / If NO, DO NOT Check Box and Explain Why in Comments Area Below.

O

Comments# I[-1:%

2. The setting is selected from an array of options that are non-disability specific (includes private room in home)

- The setting is selected by people from among residential and day options that include generic settings.
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After an assessment is completed and saved, editing access is denied.

[

After an assessment is completed and saved, ALL fields are

grayed out. The provider will not have access to edit data. Assessment

Last Updated by dmollack at 9/12/2014
12:22:14 PM

Division of Developmental Disal

File - History - Spell Check - Save Assessment - Save and Close gsessment - - Print

HCBS CheckList

Provider Assessment

Review * [Assessment
Review Date * loj12/201a
Fund Code * MR

Approved Date loj12/201a

Expired

I
IComplete
] Details

Region* [Region1

Provider Type* &

prpder/ Cortited I—

SubContractor®

Site#* 999
Service Type™ |Employment (Work crew)
Size Capacity* 999

Section I: HCBS CRITERIA

1. The setting is integrated in and supports full access fo the community (work, live, recreate, and other services). There are opportunities to seek employment and

work in integrated settings, engaqge in community life Jand control personal resources.
gularly access services similar to those used by the community at large?

- Are transportation and other supports provided so that people can

- Can people regularly interact directly with other members of the cgmmunity who are not paid to do so?

Response # I-1: If YES, CHECK BOX and List Evidence to Support iff the Comments Area / If NO, DO NOT Check Box and Explain Why in Comments Area Below.

O

11
Comments# I-1: Test
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Please Note: The following guidelines are for the Regional Office only.
The Regional Role is granted access to “duplicate” and “reverse status” for the HCBS CheckList Assessment.

The “duplicate” function is used to make any corrections to an assessment. Needed for maintaining the history of each
assessment record.

The “reverse status” places the record in “pending” status for the user to return to the assessment to update the record.

About
Change Rola %
| Regional Office V|
Welcome, 9/12/2014 1:19 PM
\ My ADIDIS == | [Fasks I
1 Alert Notes =1 My Management
0 Unread Alert Notes Current Active Cases
Quick Search )
Pending Assessments Queue
Clients W El Plans
Last Name V] Event Ticklers

Pending Investigation Assessment Queus
= My Claims
sulk Void and Replace

advanced Search

‘ Clients | Batch Claim Entry
_Providers | “=——————— Click on Providers chapter. Sinale |l Entry)
‘ Claims |
[ utilities |
| Reports |

|

‘ Sign Out

Enter the provider’s name.

About
Enter providers full or partial name in either of the
highlighted fields.

Welcome, 9/12/2014 12:39 PM

‘ File - Add New Provider - Print

Advanced Search

Change Role

| Regional Office V|

| My ADIDIS

Filter
Quick Search [ erovider name ~|[Begins with M [[anD |

] [x][ Active v|[Equal To w|[ves |[anD ~]
|Provider Number V“ﬂl

‘Provider Name Vl

Advanced Search

| Clients

|
|
| Claims |
|
|

[ utilities

| Reports

| Sign Out ‘
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The names of providers meeting the search criteria will appear. Select the provider by clicking on the name.

About

Change Role
| Regional Office

| My ADIDIS

Quick Search

‘ Provider Name

Advanced Search

| Clients

| Claims

[ utilities

| Reports

| Sign Out

Fila - Print

| |10 |Provider Name

A list of providers' names mesting the search criteria will appear.

Provider Number Street

[z [Epmimn] resiev (15 ecorie s time [ [msiind]

The provider’s demographic information screen will appear.

Harmony v7.7.0.0 File

About

Change Role
| Regional Office

[ My ADIDIS

Quick Search

| Provider Name

~]

Advanced Search

| Clients

| Claims

| utilities

| Reporis

| Sign Out

Edit  View In

File - Add New Provider - Print

Edit - Edit Provider

View Inquirias

Provider ID
Provider Number
Provider Name

Providers Enrollment

Assessment Clients
Basic Information
Provider Name

Short Name (DBA)
Center Number

EIN

IRSStatus

Active

NPT

Year Incorporated
Contact Information
Contact Name

Street

Streat 2

City

State

Zip Code

Region

Correspondence Address
Correspondence Street

Active
Capacity

T'

Workers Provider Level Budgets Services Provider ID Mumbers

Notes | Credentials | Experience

Funded By

Medicaid Approved
Provider Type

Exclude from Dropdown
Wait List Coordinator
Waiver Coordinator

RO Fiscal

: §
° in

Comment

County Montgomery

Phone
Extaension

F ITH

Montgomery
AL

36130
Region2

Fax
Email
Websita

Correspondence State
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Last Updated by cweldon at
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Available
Availability

Categories



Click on the Assessment tab to view the provider’s assessments.

Fe Vi s

About

Assessment

Click on the Assessment tab.

Change Role

| Regional Office V|

Last Updated by cweldon at
8/29/2014 12:16:04 PM

| My ADIDIS | File - Add New Provider - Add Assessment

View Inquiries

Quick Search

T ] Prnacer m ves et
- Provider Number Capacity Availability
[Provider Hame v |
Advanced Search Providers nrollment Workers Provider Level Budgets Services Provider ID Numbers Categories
Assessment Clients MNotes Credentials Experience

Clients i : : fadl

| | e A grid will appear listing the
v .

| | [2ssessment v |[add] assessments for the provider.
[ claims | Search || Reset
[ utilities |
| Reports [l re-ecment Review  Review Date m-l
| Sigl'l Out | HCBE CheckList | Assessment | 03/12/2014 Complete

Retreva [15_| Racords at = tme |:| e

Select the assessment by clicking on the line with the HCBS Checklist listed.
File  View Inqures |

About
Assessment
Change Role
| Regional Office v|
[ . - Last Updated by cweldon at
) = 8/20/2014 12:16:04 PM
| My ADIDIS | File - Add New Provider - Add Assessment - Print
View Tnquiries
Quick Search
C_ ] provider - e ves avaiable
- Provider Number Capacity Availability
[Providers | A
| Provider Name v\
Advanced Search Providers | Enrcliment | Workers | Provider Level Budgets | Services | Provider ID Numbers | Categories
Assessment | Clients | Naotes | Credentials | Experience
[ clients | Filter
| | [assessment_v/|[add] lick on the HCBS Checklist Assessment.
| Claims | Search || Reset
| utilities |
| Reports |
| Sign Out | HCBS CheckList | Assess 03/12/2014 — Complete

) (B vevve 15 Recort o2 tme. (i) (il
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The original assessment cannot be edited. All fields are grayed out. The purpose is to maintained a record of all
information entered for the Assessment.

All fields are grayed out. This means that editing access is not

Assessment
granted.

Division of Developmental Disabilities Last Updated by dmollock at 9/12/2014

12:33:14 PM

file - History - - Duplicate Assessment - Save Aszessment - Save ghd Close Assessment - Delete Assegfment - - Reverse Stitus - Print - Close Assessmant

HCBS CheckList

Provider Assassmant

Review * [assessment Worker * [Mollock, Deboral Details
Review Data * [o/12/2014 Status [complete

Fund Code * W Apprgffed By |Mollock, Deborah Details
Approved Date W Expfration Date li B

Expired

Region* [Region1

Provider Type* @
Provider/ Certified ;
SubContractor* 3

Site#* 999

Service Type™ |Emplwment {Work Crew)

Size/Capacity™* 999

Section I: HCBS CITITERIA

1. The setting is integrated in and supports full access to the community (work, live, recredte, and other services). There are opportunities to seek employment and
work in integrated settings, engage in community life, and control personal resources.

- Are transportation and other supports provided so that people can regularly access services similar to thosa used by the community at large?

- Can people regularly interact directly with other members of the community who are not paid to do so?

Response # I-1: If YES, CHECK BOX and List Evidence to Support in the Comments Area | If NO, DO NOT Check Box and fieplain Why in Comments Area Below.

o

Comments# I-1:* Test
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Use the “Duplicate Assessment” feature to make a copy of the assessment to enter changes.

The "Duplicate Assessment" is a featured used to

A t
make a copy of the original to update information. ssessmen

Last Updated by dmollock at 0/12/2014
12:33:14 PM

File - History - - Duplicate Assessment ##&ve Assessment - Save and Close Assessment - Delete Assessment - - Reverse Status - Print - Close Assessment

HCBS CheckList

Provider Assessment

Review * \Assessment Worker * ’ﬁ— Details
Review Date # 9/12/2014 Status * Complete

Fund Code * MR Approved By \_ Details
Approved Date 9/12/2014 Expiration Date
Expired

Region* [Region1
Provider Type* @

Provider/Certified

SubContractor L

Site#* 999

Service Type® |[Employment (Work Crew)

Size/Capacity™* 099

Section I: HCBS CRITERIA

1. The setting is integrated in and supports full access to the community (work, live, recreate, and other services). There are opportunities to seek employment and
work in integrated settings, engage in community life, and control personal resources.

- Are transportation and other supports provided so that people can regularly access services similar to those used by the community at large?
- Can people regularly interact directly with other members of the community who are not paid to do so?

Response # I-1: If YES, CHECK BOX and List Evidence to Support in the Comments Area / If NO, DO NOT Check Box and Explain Why in Comments Area Below.

b

Comments# I-1:%
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A new copy of the assessment is displayed. The assessment’s fields are not grayed allowing access to update
information as needed.

File

[

A new copy of the assessment is created. Editable fields are displayed. Assessment

9/12/2014 12:58 PM

File - Spell Check - - Save Assessment - Save and Close Assessmaglf- Copy From Pgevious - - Prijnt - Close Assessment

HCBS CheckList

Provider Assessment
— whoer
Review Date * o/12/2014 |7 Stbtus *

Fund Code *

Dretails

adproved By |

Approved Date iration Date

Expired

Region™ Regionl W

Provider Type*

Provider/ Certified
SubContractor*

Site#™*

|

Service Type™ |Employmant (Work Crew) Vl

Size/Capacity*

0 B H RIA
1. The setting is integrated in and supports full access fo the community (work, live, recreate, and other services). There are opportunities to seek employment and
work in integrated settings, engage in community life,fand control personal resources.

- Are transportation and other supports provided so that people can refularly access services similar to those used by the community at large?

- Can people regularly interact directly with other members of the comfmunity who are not paid to do so?

Response # I-1: If YES, CHECK BOX and List Evidence to Support in ll{

Comments# I-1:%

pComments Area / If NO, DO NOT Check Box and Explain Why in Comments Area Below.

Test
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Select “Assessment” from the Review dropdown. Information may be updated.

Select Assessment from the Review dropdown then A t
continue to edit the document as desired. ssessmen

9f12/2014 12:58 PM

File - Spell Check - - Save Assessment - Save and Cj#€a Assessment - Copy From Previous - - Print - Close Assessment

HCBS CheckList

Provider Assessment

S p— Worker L .
Review Date * 9/12/2014 [ Status =

Fund Code *

Approved By |

Expiration Date

=
o

Approved Date

Expired

Region* Regionl W

i *
Provider Type ) Cantractor

(0 subContractor
e cered (N [
SubContractor® e
st
Service Type* |Emplnyment (Work Crew) v|

s/ coper”

Section I: HCBS CRITERIA

1. The setting is integrated in and supports full access to the community (work, live, recreate, and other services). There are opportunities to seek employment and
work in integrated settings, engage in community life, and control personal resources.

- Are transportation and other supports provided so that people can regularly access services similar to those used by the community at large?

- Can people regularly interact directly with other members of the community who are not paid to do so?

Response # I-1: If YES, CHECK BOX and List Evidence to Support in the Comments Area / If NO, DO NOT Check Box and Explain Why in Comments Area Below.

Comments# I-1:*

Test

Use the “Reverse Status” feature to place the record in edit mode for user updates.

Reverse Status to place record in edit mode.
Assessment

Last Updated by c at
9/25/2014 8:41:38 AM
File - History - Spell Check - Duplicate A t - Save A

t - Save and Close Assessment - - - Reverse Status - Print - Close Assessment

HCBS ChecklList

Provider Assessment

Review * Assessment Worker * —— Details
Review Date * 9,/22/2014 Status * Complete

Fund Code * MR Approved By _— Details
Approved Date 9,/25/2014 Expiration Date |

Expired

Region™ Regionl
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The assessment’s status will be changed to “Pending.”

Status will changed to "Pending" Assessment

Last Updated by ¢ at
9/25/2014 8:41:38 AM
File - History - Spell Check - Duplicate Assessment - Save Assessment - Save and Close Asse sment - - - - Print - Close Assessment

HCBS CheckList

Provider Assessment

-

Review * Worker * I | [cer oo
evewome 27z T Stas -

Fund Code * Approved By
Approved Date W Expiration Date

Expired

Details

|

Region™ Regionl %

Fields are placed in edit mode. Updating can be made at this point or the document may be saved for user to update.

Certain fields are placed in edit mode.
£

Assessment

Last Updated by dmollock at 5/25/2014
8:41:38 AM
File - History - Spall Check - Duplicate - sava Save and Closh A:

£ - - - - Print - Close Assessment.

HCBS CheckList

Provider Assessment
- orker © [ e
Raview Data + 9/22/2014 | Status * Pending V'

Fund Code * Approved By ] Details
Approved Date l9/25/2014 Expiration Dats

Expired

Region™ Regionl V'

) -
Provider Type’ Contractor

SubContractor
SubContractor*
Site#* 99999

Service Type® |

ial < 6 pp v
o
e ection - HCBS CRITERIA

1. The setting is integrated in and supports full access to the commur ity (work, live, recreate, and other services). There are opportunities te seek employment and
work in integrated settings, engage in community life, and control pe "sonal resources.

- Are transportation and other supports provided so that people can regularly access serviles si

lar to those used by the community at large?

- Can people regularly interact directly with other members of the community who are not [iaid to do s0?

Rasponse # I-1: If YES, CHECK BOX and List Evidence to Support in the Comments Area / IfNO, DO NOT Chack Box and Explain Why in Commants Area Below.

Comments# I-1:%

testq I-1
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After the assessment is completed, place Status at “Complete” and “Save” assessment.

Save assessment. Assessment

9/12/2014 1:06 PM
File - Spall Check - - Save Assessment - Save and Close Assessment - Copy From Previcus - - Print - Clase Assessment

HCBS CheckList

Provider Assessment

Review * Worker * (N |.[clear|oeuis
Review Date * 9/12/2014  |° Status * Complete V'

Fund Code * Approved By | Detsils
Approved Date 9/12/2014 Expiration Date

Expired

Region™ Regionl W

Provider Type* .

Contractor
) SubContractor
Provider/ Certified E 00 L [
SubContractor®
Service Type™ |Employment (Work Crew) V|

el opmcy

CBS CRITERIA

1. The setting is integrated in and supports full access to the community {work, live, recreate, and other services). There are opportunities to seek employment and
work in integrated settings, engage in community life, and control personal resources.

- Are transportation and other supports provided so that people can regularly access services similar to those used by the community at large?
- Can people regularly interact directly with other members of the community who are not paid to do so?
Response # I-1: If YES, CHECK BOX and List Evidence to Support in the Comments Area / If NO, DO NOT Check Box and Explain Why in Comments Area Below.

Comments# I-1:+

Test RQ|

The newly created assessment is displayed in the grid.

T e e

About

Notice the copied assessment is displayed in the list of Assessment
assessments.

Change Role
| Regional Office

Last Updated by cweldon at
8/29/2014 12:16:04 PM

| My ADIDIS File - Add New Provider - Add Assessment - Print

View Inquiries
Quick Search

Provider ID |} Active Yes Auailable

Provider Number [ ] Capacity Availability

Provider Name

| Provider Name Vl
Advanced Search Providers | Enrollment | Workers | Provider Level Budgsts | Services | Provider ID Numbers | Categaries

Assessment | Clients | Notes | Credentials | Experience

| Clients ‘ Filter

| ‘ Assessment W

| claims | Search | [ Reset

| Utilities ‘

| Reports Bl oo Reven ReviewDate Worker  Fumdcode Status |

| Sign Out | | HEBS CheckList | Assessment | 09/12/2014 | W EEEEEEII = Complete
| HeBS Checklist| Assessment | 03/12/2014 | (NN | v+ Complete
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This is the end of the User Guide.
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